LDaemon

This document is provided as a step by step procedure for setting up LDaemon and common
LDaemon clients.
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What you should know before installing LDaemon:

ACTIVE DIRECTORY

If you will be installing onto a Windows 2000 Server, check to see if you are running an Active
Directory. You can easily find out by running “netstat —a >netstat.txt” at a command prompt, view
the netstat.txt file and look for LDAP and LDAPS running. If Active Directory is running it will be
necessary to configure LDaemon to use an open port other than port 389.

POSTMASTER ACCOUNT

When you install LDaemon it is a must that you use the correct Bind DN (LDAP Admin account).
This has to be your MDaemon postmaster account. If you don’t use the correct account
LDaemon will not function correctly with MDaemon, account migrations will fail, etc.



Walk-through for LDaemon installation:

& Welcome x|
YWielzome to LD aemon Setup program. T his
progranm will install LD aemon on pour computer.
2=

[tiz strongly recommended that you exit all Windows programs
before running this Setup Program.

Click Cancel to quit Setup and close any programs you have
running.  Chick Mest to continue with the Setup program .

WARMIMG: Thiz program iz protected by copyright law and
international treaties.

Ilnauthorized reproduction or distriibution of this program, or any
partian af it, may result in zevere civil and criminal penalties,
and will be progecuted ta the maximum extent pozzible under
a,

Cancel |

Welcome screen, no configuration necessary, click Next.



Setup will inztall LD aeman in the fallawing falder.

T o inztall inta a different falder, click Browse, and select
another folder.

You can chooze not toinstall LD'aemon by clicking Cancel to
exit Setup.

" Drestination Faolder

C: D aemons LD aemon Browse. .. |

< Back Cancel

Select the path you wish to install LDaemon to.



& Select Components

I the optiong lizt below, select the checkboxes for the optiohz
that you would like to have installed. The dizk space heldz
reflect the requirements af the options vou have selected.

¥ LDaemaon LDAR zerver and LDAP tools 3326k

[T Source code and development toals 4555 |
Dizk Space Aequired: 326 b
Digk Space Remaining: 14533350k

< Back

Cancel |

Select the components you wish to install.




& Select Program Manager Group x|

Enter the name aof the Program b anager group ta add
LD aemon icons bo:

LD aemon

Accessornes
Adrninistrative Toalz
ALTH

Applications
[rterret

Fultimedia

PO,

Startup

Whebddmin

< Back

Cancel |

Select the Program Manager folder you wish to contain the shortcuts to LDaemon.




&7 Start Installation

Y'ou are now ready ta install LD aeman.

buttan to reenter the installation information.

Fresz the Mext button to begin the installation or the Back

< Back

Cancel |

Click Next here, no configuration needed.




LD aemon needs zome information in order to operate properly. The
following infarmation iz used to zetup the oot DM for your LODAP
directon.

Company or organization name |a|tn.u:-:um

Select your country ILlNlTED STATES LS j
Administratar's narme |F'u:ustmaster

Administrator's email address |pnstmaster

Administration password |’“"“‘"’“‘x

< Back I Hest » I Cancel

This is the MOST important step of the installation process.

Company or Organization name: (may not contain commas)
Select your country: select from the drop-down list

Administrator's name: This has to be the Full Name of the postmaster account (it is
recommended that you check this in MDaemon’s account manager before continuing)

Administrator's email address: Include the domain name (example postmaster@altn.com)

Administration password: Has to match the password for the postmaster account within
MDaemon.

Click Next.

This will conclude the LDaemon installation.



FROM THE MDAEMON MANUAL.:

LDaemon LDAP Server Support

Support for Alt-N Technologies’ LDaemon LDAP Server has been integrated into MDaemon.
LDaemon provides corporate-wide global address book capability compatible with virtually all
email clients including Microsoft Outlook, Outlook Express, and Eudora. It is an LDAPv3 Windows
NT/2000 port of open-source SLAPD, developed by the University of Michigan and enhanced by
Alt-N Technologies for use with MDaemon. It is distributed as a separate module and installed in
plug-in fashion.

You can acquire LDaemon from http://www.altn.com/LDaemon/.

Several controls have been placed within the MDaemon that allow you to start, stop, and monitor
the status of LDaemon, including a configurable command line for starting it. This optional
configuration setting allows you to start the LDaemon service using any or all of the LDAP
server's command line switches.

For example: "-h Idap://:1001" starts LDaemon using port 1001 rather than the default port of 389.



LDAP Options

LDAP Optionz I LD aemon LOAP Server I Address Books I

LOAPF options

C8

LOAP zerver properties

Mote: LDAP functionality under "indows 35 requires IE 3 or greater.
% |ge standard flat file USERLIST.DAT as account database.

" |ze LDAP zerver az complete backend uzer databaze [FRO wersion only]

¥ Mirror account email addreszes and full names to LDAP address book

Thiz option keepz an LOAP zerver up to date with addrezs information.

Host name or IP Imail.altn.u:u:um Fort 383

Base enty DM |u:u=a|tn.u:-:|m, e=l1S
RDH filter | mail=$E M| LS
Bind DM Icn;ﬁ.dministratur, oaltr.com, c=U5

Bind password Ixxxxxxxx

Object clazz IMDaemDnU - Configure |

See the MDaemon Uzers Manual for an explanation of these LDAP fields.

k. I Cancel

LDAP Options
Use standard flat file USERLIST.DAT as account database

Choose this option if you want MDaemon to use its internal USERLIST.DAT file as the
account database. This is MDaemon’s default setting and causes all of the MDaemon user
account information to be stored locally.

Use LDAP server as complete backend user database (PRO version only)

Select this option if you want MDaemon to use your LDAP server as the MDaemon user

database rather than its local USERLIST.DAT system. You might want to use this

112 LDAP/ADDRESS BOOK OPTIONS 113
method of maintaining your user information if you have multiple MDaemon servers at

different locations but want them to share a single user database. Each MDaemon server
would be configured to connect to the same LDAP server in order to share user information
rather than storing it locally.
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Mirror account email addresses and full names to LDAP address book

If you are using the default USERLIST.DAT method of maintaining your account database
rather than the LDAP server method, you can still keep an LDAP server up to date on all of
your users’ names and email addresses by enabling this checkbox. Thus, you can use the
LDAP server as a global address book system for your users without having to use it as a
complete backend user database.

LDAP Server Properties

Host name or IP
Enter the host name or IP address of your LDAP server here.

Port
Specity the port that your LDAP server is monitoring. MDaemon will use this port when
posting account information to it.

Base entry DN
Enter the distinguished name of the base entry (root DN) that will be used in all of your
MDaemon user entries.

RDN filter

The relative distinguished name (RDN) is the leftmost component in each entry’s
distinguished name (DN). For all peer entries (those sharing a common immediate parent)
the RDN must be unique, therefore we suggest using the email address of each user as their
RDN to avoid possible conflicts. Using the $EMAILS macro as the value of the attribute
that you specify in this control will cause it to be replaced by the user’s email address when
their LDAP entry is created. The user’s DN will be comprised of the RDN plus the Base
entry DN above.

cHAPTER 7 114 Bind DN Enter the DN of the entry to which you have
granted administrative access to your LDAP server so that MDaemon can add and modify your MDaemon
user entries. This is the DN used for authentication in the bind operation.

Bind Password
This password will be passed to your LDAP setver along with the Bind DN value for
authentication.

Object class
Specity the object class to which each MDaemon user’s entry must belong. Each entry will

contain the objectclass= attribute with this as its value.

Configure

Click this button to open the LDAP.dat configuration file in a text editor. It is used for
designating the LDAP attribute names that will correspond to each MDaemon account field.

LDAP/ADDRESS BOOK OPTIONS
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LDaemon LDAP Server

This tab is used to control Alt-N Technologies’ LDaemon LDAP server. Note: these
controls will not be available until LDaemon has been installed. LDaemon can be
downloaded free of charge from ftp://ftp.altn.com/LDaemon/.

LOAP Optione  LD'aemon LODAP Server | Address Books I

LD aemon LOAP zerver properties
Lorenon  Mote: LDaemon requires YWindows MT /2000,

win ¥ Start & Stop LD'aemon when MO asmon starts & stops

LD aemon command line [optional]:

Ex '“h ldap: /41001 ar "-h “ldapz:/¢ Idap: A1 27 0.0.1: 666"

Edit LD'aemon configuration file Stop & Restart LDaeman

k. I Cancel

LDaemon LDAP Server Properties

Start & Stop LDaemon when MDaemon starts & stops
Click this checkbox if you want to launch the LDaemon LDAP server when MDaemon
starts, and stop it when MDaemon stops.

LDaemon command line (optional) 1f you wish to utilize some command line
switches for LDaemon you can do so by typing the command line into this control.

Edit LDaemon configuration file
Click this button to open the LDaemon configuration file for editing in the default text

editor.

Stop & Restart LDaemon
After make any changes to LDaemon, click this button to stop and restart the LDAP server

so that your changes will be implemented.
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LDaP Options I LLaemon LOAR Server  Address Books |

YWindows Address Book [wAB] options
LEE! M ate: WiAB functionality under Windows 95 requirez |E 3 ar greater.

[ Mirror email addreszes and full names to wWindows Address Book
Thiz optian keeps vour WAB up o date with address infarmation.

Uze thiz specific 'WaE file

I Browze |

Leave thiz control empty and MO aemon will use the "Shared Contacts' within
the default Windows address book.

k. I Cancel

LDAP/ADDRESS BOOK OPTIONS

Address Books

MDaemon version 5 has the ability to automatically keep a Windows Address
Book file (*.wab) or Microsoft Outlook Contact Store current with each account’s
full name and email address. This is desirable for those who wish to share an
address book among users of products like Outlook, but do not wish to use an
LDAP server for that purpose.

Mirror email addresses and full names to Windows Address Book

Enable this checkbox if you want your users’ names and email addresses to be
mirrored to a *.wab file or the Microsoft Outlook Contact Store. In the Windows
Address Book, on the Tools|Options menu, you can configure whether or not
your Windows Address Book will share contact information between Outlook and
other applications by storing data in the Microsoft Outlook Contact Store or
maintain it in an address book (*.wab) file.

Use this specific WAB file

Specify the path to the *.wab file in which you wish to mirror your user
information. If you leave this control empty then MDaemon will use the shared
contacts store within the default Windows Address Book.
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Configure Outlook XP for use with LDaemon
server.

From Outlooks menu select “Tools”, then “Email Accounts”.

2l

E-mail Accounts
¥ou can change the e-mail accounts and directaries that Outlook uses, ;

E-mail
" add a new e-mail account:

£~ Miew or change existing e-mail accounts

Directory
¥ add a new directory or address book

™ Wiew or change existing directories or address books

< Back I MHext = I Cloze

Select “Add a new directory or address book” located underneath “Directory” and click
Next.



E-mail Accounts

Make sure “Internet Directory Service (LDAP)” is selected and click Next.
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i

Directory Service (LDAP) Settings
¥ou can enter the required settings to access information in a directory service, ]

Server Information

Type the name of the direckory server wour Internet service
provider or system administrakor has given you,

Server Mame: rnail. altr. corn|

Logon Information

[ This server requires me ko log on

[ser [ame: I

Fassiword; I

Moare Settings ... |
¢ Back I = I Cancel |

Type in your servers IP or hostname.domainname.toplevel and click “More Settings...”

This window may pop-up:

Add E-mail Account x|

@ The E-mail Account vou hawe just added will not start unkil wou choose Exit From the File menu, and then restart Microsoft

Qutlook,

Ignore this, you can click OK.

16



Microsoft LDAP Directory x|

Connechion | Search I

—Display Mame

The display name as it appears in the Address Book

— Conneckion Details

Part: |389
I Secure Sockeks u
Layer

k. I Cancel Smply

Display name field doesn’t effect anything, its for your eyes only.
The Port field should match the port that you specified in LDaemon’s configuration.

17



Microsoft LDAP Directory x|

Connection  Search I

—Server Settings
Search timeaout in seconds:

Specify the maximum number of entries wou T
wish ko return after a successful search:

EE

—Search Options

Search base;

Example:
cn=users, dc=exchange, dc=microsaft, dc=com

k. I Cancel Apply

You may specify timeouts, but the defaults are fine. You can tweak on these for slow
network connections.

Search Options
The search base is the most important part of the client configuration.

This should EQUAL what you specified as the “Base DN” in LDaemon’s configuration.
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Outlook 2000

To add a directory service to Outlook 2000 start by selecting the Tools menu, then

Accounts.
This window should appear.

Internet Accounts T B

all hail I Directony Service I

Add

r

Account | Tupe

| Connection

rnail [default)

imail. altn. com

Local Area Hetwark,

Bemove

Properties

Seh as [efault

Irnpart...

Export...

Set [Wrder...

Cloze

Select Add then Directory Service.
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Internet Connection Wizard

Internet Directory Server Hame

Type the name of the [ntemet directon [LDAP] server pour [ntemet service provider or
gystem adminiztrator has given you,

Internet directony [LDAF] zerver: Imail.altn.n:n:um

[f wawr Internet zervice provider ar system administratar has informed you that they
require you o log on to your LDAP server and has provided you with an LDAF account
hame and pazsword, select the check box below,

[~ My LDAP server requires me ta log on

< Banh Hest = Cancel

In the Internet directory (LDAP) server field enter the host name and FQDN of the LDAP
server you will be connecting to. Click Next.

20



Internet Connection Wizard

Check E-mail Addresses

This option when enabled will check your addresses, automatically, after entering them
into the To:, CC:, and BCC: fields of new emails. Make your selection and click next.

21



Internet Connection Wizard

Congratulations

Click Finish. But you are not done configuring the LDAP client. You still need to tell
the client how it will be searching the directory.

22



Internet Accounts T B

all | b il Directomy Service | &dd b
Account | Tupe | Connection | Bemove
% jared. altn. com directony service Local Area Metwark, .
% |dap. altn. com directony service Local Area Metwark, Eroperties
{mail.altn.com [1] directomny semvice Local Area Hetwork, St e Derau
Irnpart...
Export...
Set Order...
Cloze

Select your directory service and click properties.
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5 mail.altn.com (1) Properties

miail. altn. com [1)

rail.altn. com |

r

.ﬂ'.'::'::':“.lrl-r. =1 |
EEESIATITHE |

| B8 o | g e = = et e = =

Apply

Verify the settings here and select the Advanced tab.
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™4 mail.altn.com {1) Properties

General Advanced |

Server Port Humber

Directony service [LOAP]: IEEEl [Jse [Werault |

[T This server requires a secure connection [S5L]

Search

Search himeout:
Short = J———— Long 1 minute

M axirurn number of matches o return: 100 -

Search baze: ||:|=.-'-‘«Itr'|. com, c=us

[T Uze simple search filter

ak. I Cancel Apply

Server Port Number

By default you will be using port 389, in some cases you may be running an Active
Directory on your server and would have configured LDaemon to use a port other than
389, if this is the case edit the LDAP port to correspond to the port you configured LDAP
to use.

Search

The search base is the same thing as the Base DN in your LDaemon/LDAP configuration.
So enter the search base/base DN accordingly.

25



Outlook Express 5

To add a directory service to Outlook Express 5 start by selecting the Tools menu, then
Accounts.
This window should appear.

Internet Accounts ied |

M1 | Mal | Mews Diecton Service | Add >

Account | Type | Connection | | Remove I
% Bigfoot Internet ... directony service Local &rea Network

Propertiesz |

Set as Mefault |

[rpart... |

Expart... |

Set Order... |

Cloze |

To add the directory service, select Add then Directory Service.

26



The following window will appear.
x

Internet Directory Server Hame

Type the name af the [nternet directany [LDAP] server pour Intemet service prosvider or
gugtem adminiztratar has given pou.

Internet directon [LOAP] server: Imail.altn.cu:um

[F wour Internet zervice provider or system administrator has informed pou that they
require you ta log an to your LODAP server and has provided vou with an LDAP account
name and pazzword, zelect the check box below.

[ My LDAP zerver requires me to log on

¢ Black Mext » | Cancel |

In the Internet directory (LDAP) server field enter the host name and FQDN of the LDAP

server you will be connecting to. Click Next.
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Internet Connection Wizard El

Check E-mail Addreszes

'our e-mail program checks the e-mail addresses of pour meszage recipients Using one
or more directon service addrezs lists.

Ilzing a directony service to check the e-mail addrezzes of your message recipients may
glow down the performance of wour e-mail program.

Do you want to check addreszes uzing this directany zervice?
% Yes
i~ Mo

< Back I M et = I Canicel

This option when enabled will check your addresses, automatically, after entering them

into the To:, CC:, and BCC: fields of new emails. Make your selection and click next.

28



Internet Connection YWizard

Congratulations

Click Finish. But you are not done configuring the LDAP client. You still need to tell
the client how it will be searching the directory.
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Internet Accounts 7] x|

All I b il | Mews Directon Service I

Account | Type | Connection | Femove |
‘ Bigfoot Internet 0. directon service Local Area Network, _
(53 jared. altn.com directarny zervice Sy Available Propertiss |
Set as Default |
[rpart... |
Export... |

Set Order... |

Cloze

Back at the Internet Accounts window we need to highlight our new service and click
Properties.




E’-_ mail.altn.com Properties 2=

General | Advanced

Directary Service Account

Type the name by which vou would like to refer to thiz
| gerver. For example, ""work Directorny' or “Microsoft

Drirectary Server''.

il altn. com

Server Infarmatian

S erver name: Imail.altn.u:u:um

[ Thiz server requires me ta log on

Aroaunt nanme; I

Fazzword: I

™| Log onjusing Secure Fassword Suthentication

¥ Check names against thiz server when zending mail

k. I Cancel Lpply

You won’t be needing to configure anything here, it should already be set accordingly. If

you see an error here you may correct the problem. Select the Advanced tab and move
on.
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% mail.altn.com Properties ed |

General  Advanced

Server Port Mumber
Directory zervice [LDAP):

=g [Default |

[T This server requires a secure connechion (S50

Search

Search himeaut:
Shot = F——— Luong 1 mirute

b auirurn nurnber of matckes ba retune; 100 -

Search base: In:n=a|tn.n::n:nn'|, =15

[~ Use zsimple search filter

k. I Cancel Apply

Server Port Number

By default you will be using port 389, in some cases you may be running an Active
Directory on your server and would have configured LDaemon to use a port other than
3809, if this is the case edit the LDAP port to correspond to the port you configured LDAP
to use.

Search

The search base is the same thing as the Base DN in your LDaemon/LDAP configuration.
So enter the search base/base DN accordingly.
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